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Bee Software Ltd.

EELL  MMeennuu
Software License Agreement

- READ THIS CAREFULLY BEFORE USE -

You are purchasing a license to use the EL Menu Software. The Software is owned and remains the
property of Bee Software Ltd, is protected by international copyrights, and is transferred to the original
purchaser and to any subsequent owner of the Software media for their use only in accordance with the
license terms set forth below. Opening the package and/or using the EL Menu Software indicates your
acceptance of these terms. If you do not agree to all the terms and conditions, return the Software,
manuals and any partial or whole copies within thirty days of purchase for a refund, subject to any
applicable restocking fees.

Use of the Software
Bee Software Ltd grants the original purchaser (Licensee) the limited rights to possess and use the EL
Menu Software and User's Guide for its intended purposes. Licensee agrees that the Software will be
used solely for Licensee's internal purposes. If the Software is installed on a networked system that
physically allows shared access to the Software, Licensee agrees to provide technical or procedural
methods to prevent use of the Software by more than one user.

One machine-readable copy of the Software may be made for back-up purposes only, and the copy
shall display all proprietary notices, and be labelled externally to show that the back-up copy is the
property of Bee Software Ltd and its use is subject to this License. No part of the documentation may be
copied.

Software is Licensed to a Single Specific User
The EL Menu Software is licensed to a single, specific user. It is not a concurrent use license. Use of the
software by more than one person requires purchase of additional copies of the Software or a site
license.

Distributable Components
Licensee may transfer its rights under this License, provided that the party to whom such rights are
transferred agrees to the terms and conditions of this license, and written notice is provided to Bee
Software Ltd. Upon such transfer, Licensee must transfer or destroy all copies of the Software.

Licensee MAY NOT modify, reverse engineer, de-compile or disassemble the software, or modify or
reproduce the program in this License.
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LIMITED WARRANTY
EXCEPT AS SPECIFICALLY STATED IN THIS AGREEMENT, THE SOFTWARE IS PROVIDED AND
LICENSED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

Bee Software Ltd warrants the Software media to be free of defects in workmanship for a period of ninety
days from purchase. During this period, Bee Software Ltd will replace at no cost any such media
returned to Bee Software Ltd, postage prepaid. This service is Bee Software Ltd's sole liability under this
warranty.

DISCLAIMER
LICENSE FEES FOR THE SOFTWARE DO NOT INCLUDE ANY CONSIDERATION FOR ASSUMPTION
OF RISK BY BEE SOFTWARE LTD, AND BEE SOFTWARE LTD DISCLAIMS ANY AND ALL LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF OPERATION OF OR
INABILITY TO USE THE SOFTWARE, EVEN IF BEE SOFTWARE LTD HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. FURTHERMORE, LICENSEE INDEMNIFIES AND AGREES TO HOLD
BEE SOFTWARE LTD HARMLESS FROM SUCH CLAIMS.

THIS WARRANTY GIVES YOU SPECIFIED LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS
WHICH VARY FROM JURISDICTION TO JURISDICTION. SOME JURISDICTIONS DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF WARRANTIES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS
MAY NOT APPLY TO YOU.

This License is the complete and exclusive statement of the parties' agreement. Should any provision of
this License be held to be invalid by any court of competent jurisdiction, that provision will be enforced
to the maximum extent permissible, and the remainder of the License shall nonetheless remain in full
force and effect.

This License is governed by the laws of England and Wales. Any action or proceeding brought by either
party against the other arising out of or related to this agreement shall be brought only in a court of
competent jurisdiction located in England. The parties hereby consent to in personam jurisdiction of said
courts.
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About this Guide
This guide has been written to help you get started using EL Menu. It includes an
overview of the program's options and facilities and gives you an idea of what
you can do with the program.

This guide assumes that you already know how to use your PC and Microsoft
Windows™.

Structure

This guide takes you from an introduction to EL Menu, through installation and
set-up, to an overview of each aspect of the program.

• Chapter 1 gives an overview of the program.

• Chapter 2 gives instruction on installation of the program including
hardware requirements as well as the procedure for registering the program.

• Chapter 3 leads you through your first time using the program and briefly
introduces various aspects that will be covered later in the guide.

• Chapter 4 deals with each aspect of the program in detail and gives tips on
how to make the best use of each aspect while you are working with the
program.

• Chapter 5 is a step by step guide to creating your first Menu disk.

• Chapter 6 includes a place to record your customer details and registration
number which you will need for e-mail support.



About this Guide

8

Other Related Documentation

In addition to this guide, you may want to consult.

• The on-line Help text. It includes an introduction to EL Menu and details of
all aspects of the program.

• The manuals and other documentation for your PC and Microsoft Windows.
• The owner's manual for your EL Electone.



1. Introducing EL Menu

EL Menu User Guide v1.0 9

1. Introducing EL Menu
This chapter includes a brief introduction to Menus and provides an overview of
EL Menu including a list of key features.

1.1 What is a Registration?

The word 'Registration' has been applied to keyboard instruments for centuries. It
stands for the settings that a player makes to an instrument before or while
playing. On a pipe organ this would be done by selecting and combining various
stops (registers). The resulting setting of the instrument would be called the
registration.

In Electones there are hundreds of different sounds, rhythms and effects so it has
become more important to be able to store these registrations. There are up to
16 registration buttons on the EL range of Electones and these can be used to
store the current registration of the EL voices and rhythms.  Virtually all the
settings that are made on the panel can be stored, but there are exceptions.

• Type setting in Reverb
• Type setting in D.R.E (available on some ELs)
• Attack Mode in Flute Voices
• Pan, Reverb and Volume settings in the Rhythm Instrument page (ELX-1,

EL900/700/500)
• User Keyboard Percussion assignments (the choice of the keyboard

percussion preset can be memorized but not the actual instrument
assignments)

• Registration Shift settings
• Pitch/Transpose settings
• Voice Edit (except for the choice of User voices currently assigned to the

Dotted buttons)
• Voice Disk voices
• Rhythm Pattern Program patterns (except for the choice of User rhythm

patterns currently assigned to the Dotted buttons)
• Rhythm Sequences
• MIDI settings
• Lead Initial Touch setting (ELX-1, EL900)
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The use of 'User' voices and rhythms deserves a special mention. These are
stored and retrieved to the EL by the disk drive as a block of 16 voices and 40
rhythm patterns. Registrations only contain information about which of these have
been selected on the panel and not the actual data of the voice or rhythm. This
becomes significant in the creation of Menu disks because the actual voices and
rhythms cannot be stored on a Menu disk, so these need to be stored separately.

1.2 What is a Registration Menu?

A Registration Menu is a special form of floppy disk that is used by the EL to
allow registrations to be chosen from the central display instead of the white
buttons.

The advantages of this system are:

• Registration Names - so that you can see what sound will be produced
• Page Names - so you can label the type of registrations in a page or the title

of the piece of music for which they are intended.
• 80 registrations are available at once (instead of 8 or 16)
• 16 registrations are visible at once.
• Choose the number of pages you want (up to 5)
• Instant loading - just put the disk in and the registrations appear (no need to

choose a track and press play).
• Assemble arrangements quickly from your favourite sounds by saving the

Menu registration to the white registration buttons in the order they appear
in your piece.
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1.3 What is EL Menu?

EL Menu gives you the ability to create your own Menu disks using a standard
Windows 95 (or above PC). You can copy your own registrations to the Menu in
an easy-to-use visual environment. You can see exactly what it will look like on
the display of the EL. The Menu system allows you to label your registrations for
you own purposes or to share them with other people.

Key Features
• Simple to use.
• Familiar controls for MDR track selection.
• Instant loading of your registrations from floppy disk or hard disk.
• 'Quick Load' function to load straight from floppy disks.
• Graphical Menu display imitating the appearance of the Menu on the EL

display.
• Graphical Registration button display.
• Transfer the registrations into the Menu by simply dragging and dropping

them on the Menu display.
• Automatic Naming (can be switched off) that reflects the origin of the

registration e.g. 'Trk1Reg1'.
• One-click Menu disk creation to a floppy disk.
• Store your Menu files on hard disk - create Menu disks only when you need

them.
• Quick loading of Menu disks from floppy disk.
• Model selection sets the program for your particular EL model.
• Copy and paste registrations or complete pages between different Menus or

within the same Menu.
• On-line Help documentation to keep you on track if you get stuck.
• All the advantages of storing your registrations in Menu disk format.

Summary
EL Menu gives you the opportunity to create your own Menu format disks in a
quick, simple to use graphical environment.
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2. Installation
This chapter details what is required to install EL Menu.

2.1 Before you install EL Menu

To install and run EL Menu you will need:

• An IBM compatible 486 or higher PC (100Mhz or above recommended)
running Windows 95 or higher. This should be a stand-alone PC, or if
connected to a network, have Windows running on the PC's local hard
drive.

• Minimum 16Mb memory and 10Mb free hard disk space.

• Minimum 256-colour VGA screen.

2.2 Installing EL Menu

Before running the installation please close all other applications except
Windows.

To install EL Menu:
• Insert Set-up Disk 1 into the floppy disk drive.
• Select the start button to display the pop-up menu, then select the Run

option to display the Run window. Type in a:setup (where 'a' is the drive
letter of the floppy disk drive). Select the OK button.

A grey box appears at the start of installation. If some of the files on your PC are
old the program may tell you that you need to start Windows again. If so then
you will have to restart the EL Menu installation again as described above. Once
you are running the EL Menu Set-up program follow the on-screen instructions to
complete the installation.
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2.3 Registration

Unfortunately there are many people who do not respect the copyright of
software producers. This makes it necessary to include some copy-protection in
the program to reduce piracy of the product. This is bound to cause a little extra
work for the legitimate user for which we apologise.

After you install EL Menu using the method described above you will not be able
to use the program until it is unlocked using the 'Key Disk' supplied in the
package.

To unlock the program
• Run EL Menu by clicking on its icon in the Start Menu>Programs list
• A box will appear stating that this product's license has expired.
• Click on YES
• A box will appear as shown below.

• Make sure the 'Key Disk' is not write-protected (tab closed). Insert the 'Key
Disk' into drive a: and click on the 'Import from A:\' button.

• Please wait while the program is unlocked.
• Click on OK.

The program is now unlocked on the PC, and will run the next time you try.
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3. Getting Started
This chapter leads you through first use of the program and takes you on a
guided tour of the main features of EL Menu.

Once you have installed EL Menu then you are ready to run the program for the
first time. Click on the Start button and move the mouse pointer to Programs. On
the pop-up list you should find 'EL Menu'. Click on this to launch the program.

The EL Menu program will appear as shown below.
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3.1 Guided Tour

The first thing we need to do is set the EL model to the one you will be using the
program with. To do this click on the down arrow in the box next to 'Model'.

You will see a choice of 3 different model types. Click on the one that matches
your instrument.  If you have an ELX-1 select the EL-90/87 option. This setting
will be remembered by the program so that you only have to do this once. It is
changed, though, if you load a Menu file into the program that was made for a
different model than the one selected.

Next we can load a Menu into the program so that you can see how the
Menu display works. If you have the Menu disk that came with your
instrument then you can load this into the program by putting it in the
disk drive and then clicking the 'Load Menu' button.

If you do not have the disk handy then click on the File
item on the menu bar and select 'Open Menu File'.

Then select the file labelled 'Demo.dat' and click
'Open'. This may not be for your particular model so
you may wish to reset the selected Model as described
above.

Once the Menu file has loaded
the screen will change to show
the names of the registrations that
are stored in the file.

To select a registration simply click on the corresponding square in
the display. The colours in the square will invert to show that the
registration is selected.

To change the name of a registration
double-click on the registration
square. A box will appear into which
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you can type the new name. You can enter up to 10 characters. When you have
typed in the name click on OK.

The page title is in the black band
above the 16 registration names.
You can rename this in the same way by double-clicking on it. You can type up
to 40 characters for a page title.

To change to a different page, click on either of the two arrow
buttons at the top right of the screen. These operate in the same way
as the page buttons on the EL panel. You can have up to
5 pages on a Menu file. You can change the number of
pages by choosing 'Options' on the menu bar at the top
of the screen. Moving the mouse to 'Number of pages'. A
pop up display allows you to choose how many pages
you want.

In order to put your own registrations into the Menu you must first load
them into the 'Registrations' display. When there are no registrations
loaded the registration buttons are greyed-out. To load your
registrations from a disk. Insert a normal EL registration disk into the computer
disk drive. Choose a track that contains registrations using the arrow buttons
beneath the red track number display. Then, click on the big 'Load Registration
File' button.

The registrations are loaded and
you will see the registration

buttons change to white, indicating that there are registrations ready for
transferring into the Menu. If the track on the disk does not contain registrations
then a message will appear saying that the track is empty.

To transfer a registration into the Menu, move the mouse above the white
registration button. Press and hold the left mouse button. The pointer will change
to a blue arrow. Keep the mouse button pressed and move the arrow over the
square into which you want to put the registration. Release the mouse button.
The name of the registration square changes to show the origin of the
registration. Of course you can rename it by double-clicking, typing a
new name and pressing the Enter key (or clicking on OK).

To make a Menu disk that operates in the EL, put a blank formatted disk
into the disk drive and click on the 'Save Menu' button. Wait a second or



3. Getting Started

EL Menu User Guide v1.0 17

two (or until you hear a sound) for the disk drive to finish writing to the disk.
Remove the disk and insert it in the EL disk drive slot.

After a few moments you will see the Menu in the EL display. To choose a
registration simply press the 'Data Control' button beneath the display
corresponding to the registration you want.

So, that's the end of the guided tour. As you can see EL Menu is easy to use and
some people may feel confident to get started creating their own menus even at
this point. The rest of this user guide covers each of the program's functions in
detail.
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4. Working with EL Menu

4.1 Registrations, Registration Files and Menu files

This section describes in detail the difference between these different terms.

Registrations
As explained at the start of the manual, registrations contain information about
the way the EL panel has been set up. The registrations in the white buttons and
those in the Menu files contain exactly the same kind of information.

Registration Files
These are the files on the disk that the EL creates when you save your settings to
the MDR disk drive. Registration Files in fact hold more than just registrations.
They also contain the User Voices and Rhythms along with a variety of other
global settings for the instrument. The sixteen registrations are just a part of the
MDR file.

When EL Menu loads a registration file into memory it copies the 16 or 8
registrations from the file into the white registration buttons of the 'Registrations'
display. Only these registrations can be copied to the Menu disk so, if your
registrations use User Voice or Rhythms, in order that the registrations sound
correctly you will need to load them into the organ first before using the Menu
disk.

Menu Files
Menu files have space to store 80 registrations split into 5 pages. When a Menu
disk is created the file will load and display itself in the screen automatically when
inserted in the EL disk drive.

4.2 Menu Bar

This section deals with the drop-down menus that you see at the top of the EL
Menu display.
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File
Click on the File item on the menu bar. A drop-down list appears. It is split into
three sections.

• MDR
• Menu
• Exit

You will be familiar with opening and saving files on your
computer. EL Menu uses the standard Windows system for
this. On the right of the menu options you will see the key
combinations which provide a shortcut to these functions.

'Open MDR registration file' deserves a special mention in
that it is used to load registrations into the program that you
can then transfer into your Menu. These registrations are in
the form of an MDR file (a file created by the EL internal

disk drive). The MDR files are created when you save your settings using the built-
in disk drive on the EL. They are saved with a *.b00 file extension (b, zero, zero).
They are labelled as 'Mdr_' followed by the track number. This track number is
actually 1 less than the MDR display e.g. track 01 on the Electone would be:

Mdr_00.b00

EL Menu includes a very easy way to deal with all this using the 'Load Registration
File' and track selection in the main window. The only reason that the option
appears on the File menu is to allow you to use registration files that are stored
on your PC hard drive or that you have downloaded from the Internet.

'New Menu File' replaces the current Menu display with a blank one. If the Menu
you are working on has changed since it was last saved then you will be asked
whether you are sure you want to continue.

'Open Menu File' allows you to look for a Menu file on your Hard Drive. This is
different from the Load Menu button on the main display which automatically
loads a Menu from the floppy disk drive.

'Save Menu File' saves the Menu file back to its current file location.

'Save Menu File As' allows you to choose a different name and location for the
Menu file.



4. Working with EL Menu

20

The functions above allow you to keep a library of Menu files with names that
you will be able to recognise. When an actual Menu disk is created by the
program, a special file name is used that the EL can recognise. So when you
want to make a Menu disk from your Menu file use the 'Save Menu' button on the
EL Menu display.

Edit
Clicking on Edit in the menu bar displays the Edit drop-
down menu. There are two sections one for individual
registrations and the other for complete pages of
registrations.

There is an 'Undo' facility which allows to go back to the original registration after
copying or transferring from the registration buttons. Just in case you make a
mistake.

When a Menu registration is selected you can use 'Copy Menu Reg.' to put a
registration into memory so that it can be Pasted to another location. This could
be on a different page or even a different Menu File. A shortcut for copying a
registration can be achieved by using the Ctrl + C keys together.

To paste the registration to another location select the location and then click on
the Edit menu and select 'Paste Menu Reg.' A shortcut for pasting a registration
can be achieved by using the Ctrl + V keys together.

Another very useful function is the ability to copy and paste complete pages of
registrations. Again this can be within a Menu file or you can paste a page of 16
registrations into a different Menu file.

Press either of the Page buttons to select the page you want and then choose
'Copy Menu Page' from the 'Edit' menu. The Page is stored in memory. Use the
page buttons to locate the page you wish to paste the stored page to and choose
'Paste menu page' from the 'Edit' menu. The page is pasted to the new location.
You can load another Menu file at any time while the Page is stored in memory
to allow you to move pages of 16 registrations between Menu files.
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Options

This menu turns on and off some time-saving functions and
also allows you to set the number of pages in your Menu
files.

The first three items in the list have ticks next to them when
they are turned on. To turn them on and off simply select them. They toggle
between on and off each time they are selected.

Quick Load MDR track
This governs what happens when you press the 'Load Registration File' button at
the bottom of the display. With the function turned on the program first accesses
the floppy disk drive. If there is a MDR registration disk in the drive it will try and
load the track from the disk. If the track contains registrations they will be loaded
into the program ready to be transferred into the Menu display. If the track is
empty a box will appear to tell you.

If the function is turned off the program immediately opens the EL Menu folder
on the hard drive to allow you to browse for MDR registration files in another
location. This is the same as using the Open MDR Registration file command on
the File Menu.

Quick Load Menu Disk
With this function turned on and a Menu disk in the floppy disk drive, the 'Load
Menu' button on the display causes the program to load the Menu file on the
disk appropriate for the currently selected EL model. If the function is turned off
then the button opens the EL Menu folder on the hard drive to allow you to
browse for Menu files.

Auto Naming
When a registration is transferred from the MDR registration buttons to the Menu
Display the program generates a name reflecting the original location of the
registration in the format 'TrkXRegX'. Sometimes you will not want this to happen.
If you turn off auto-naming the registration is transferred but the name on the
Menu display remains unchanged.
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Number of pages
Moving the mouse pointer to 'Number of pages' opens
up a pop-up menu with the numbers 1 to 5. Clicking
on the appropriate number changes the Menu file so
that it has the selected number of pages.

4.3 Menu Display

This section describes in detail the functions of the Menu display

Page Buttons
There can be up to five pages of registrations in a Menu file so the
Page buttons are used to move between them - the right hand
arrow moves to the next page up and the left one to the previous.

Page Title

This is in the black band across the top of the registration squares. Each page
can, of course, have a different title. This means that you can have a name that
describes the registrations collectively.

To change the name double-click on the black band. A box appears so that you
can type in the new name (up to 40 characters). Click on OK and the page is
renamed.
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Registration Names
Each square in the Menu display represents a different registration. Clicking on a
square selects the registration and the
text is inverted. To rename the
registration double-click the one you
want to change. A box appears for
you to type in the new name. Click on
OK and the registration is renamed.

Load Menu
When 'Quick Load Menu Disk' in the Options drop-down menu is
on this button opens a Menu file on a floppy disk in the computer
disk drive. The file corresponding to the currently selected model
is loaded. If the 'Quick Load' function is off then a standard file
opening window is displayed allowing you to browse the
computer file system for Menu files.

Save Menu
This button is used to make a Menu disk suitable for use in the
EL. When used it changes the volume label of the floppy disk so
that the EL recognises it as a Menu file. It is important to
remember that if you use a disk that isn't blank then the EL will not
be able to access any of the files on the disk other than the Menu
file (you cannot change tracks). You can of course copy the files
you want onto another disk but it is much better to make sure that

you keep Menu files and normal registration files separate.

4.4 Registration Display

This is where the registrations from the MDR registration files are loaded ready
for being transferred into the Menu display.

Registration Buttons
These are laid out in the same way as on the EL itself. In other words the leftmost
button is actually 13 instead of 1. When there are no registrations loaded the
buttons are grey and cannot be selected. They turn white as soon registrations
are available to be transferred.
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To transfer a registration to the Menu display drag the corresponding button over
the Menu display and drop it in the desired location. If Auto-naming in the
Options drop-down menu is switched on the registration name will change to
something similar to 'Trk1Reg1', reflecting the source of the registration. During
drag and drop the mouse pointer will turn into a blue arrow.

To transfer all sixteen registrations to a page at once drag the actual
'Registrations' frame/box and drop it in any of the registration squares. During
drag and drop the mouse pointer will turn into a orange disk with 'All Reg' written
on it.

If you are using an EL70 then a message will appear asking you to choose which
row you would like the 8 registrations to be loaded to - top or bottom.

Track Select
This operates in the same way as that on the EL disk drive
controls. To move between tracks on the disk you can press
the left and right arrows in the same way. Clicking on one of
the arrow increases the track number by one. If you hold the
mouse button down you can scroll through the track numbers

more quickly. You will notice that having loaded registrations into the registration
buttons, moving to a different track disables the registration buttons (turns them
grey again). This is to avoid confusion over which track's registrations are loaded
into the white buttons.

Load Registration File
When 'Quick Load MDR file' in the Options drop-down menu is on this loads the
registrations from the floppy disk track displayed in the track select window. If the
track is empty a message will be displayed. If the registrations are for a different
EL Model you will be asked if you want to continue. You can always use the
registrations from a higher model in a lower model but not the other way round
because certain panel settings would be missing. When 'Quick load' is off,
clicking on this button opens the normal 'Open Registration File' window to
enable you to browse the file system for other registration files (file extension is
b00).
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5. Step by Step to Your First Menu
Disk
This chapter takes you step by step through the process of creating a Menu disk.

5.1 Starting a New Menu

Run EL Menu by clicking on the Start button in Windows and moving the pointer
to Programs. A pop-up menu will appear and you will find the EL Menu icon in
the list. Click on this and the program will start.

Select the model number corresponding to your EL by
clicking on the model box and then on the model you have.

Click on the File menu item and then on New. This clears the currently loaded
menu file. It may already be blank but this is how you would start a new project.

5.2 Loading your registrations

Next you need to decide which registrations you would like to use on your Menu
disk. Once you have decided, place the registration disk containing your
registrations into the computer disk drive. Select the correct track number using
the track select buttons next to the
large 'Load Registration File'
button. Then click on the 'Load
Registration File' button. If there are registrations on the track then these will be
loaded into the program and the registration buttons will become white showing
that they contain registrations that are ready to be transferred.

If the registrations on the disk are not for your model you will be asked if you
want to continue. Click on 'Yes' but then change the Model back to the
instrument you have.
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5.3 Transferring and naming your registrations

To transfer your registrations all you need to do is drag and drop the desired
registration button onto the Menu display. To do this, place the mouse pointer
over the registration you want to transfer. Press and hold the left mouse button.
The mouse pointer will become a blue arrow. Keep the left mouse button held
down and move the blue arrow directly over the square into which you wish to
transfer the registration. Release the mouse button and the registration is
transferred. The name of the square will now be similar to 'Trk1Reg1' reflecting
the source of the registration.

If you wish to transfer all 16 of the registrations at once move the mouse pointer
to a position within the 'Registrations' box (but not actually over a registration
button) and press and hold the left mouse button. The mouse pointer will change
to an orange disk with 'All Reg' on it. Keep holding the mouse button and move
the mouse to position the disk symbol over any of the Menu display registration
squares and release the button. All 16 registration squares will be filled with the
contents of the 16 registration buttons.

The EL70 has 8 registrations available in the 'Registrations' display so if you are
transferring EL70 registrations, during this procedure you will be asked to which
row of Menu squares you want to transfer.

Transfer as many of the registrations as you like. You can put them in different
pages and you can load different registrations into the white buttons without
affecting the contents of the Menu.

It is a good idea to name the
registrations as you transfer them to
keep track of which registration is
which. Double-click on the
registration square which you wish
to name. A box will appear into
which you can type upto 10
characters. It is worth noting that there are two lines of 5 letters in the display. It
is almost always necessary to abbreviate the names in some way. Once you have
typed the new name, click on OK. You can go over them as often as you like
until they look right.
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5.4 Naming the menu page

Now that we have the registrations, we need to give each page a name. To do
that, choose the page you want to name using the page arrows and then just
double-click on the Page title bar which is immediately above the 16 registration
names. A box will appear into which you can type the new name for the page.
Up to 40 characters can be used. Click on OK to store the name.

5.5 Saving the Menu on the PC

Once you have transferred and named the registrations and pages we need to
keep the Menu file safe by saving it to the PC hard drive. Click on the File menu
item and then on 'Save Menu File As'. A window will appear for you to type the
name you wish to give the Menu file. You can be as detailed as you like. Try 'My
First Menu' and then click on 'Save'. The file is saved to the hard drive.

5.7 Creating a Menu Disk to use with the EL

Now that the Menu file is safe on the hard disk we can create a Menu
disk that can be read by the EL. You will need a blank formatted disk.
Put this in the computer disk drive and then click on 'Save Menu'
button in the Menu display. After a few moments the job is done.
Remove the disk from the disk drive and put it in the EL. The central display will
change to show the available registrations.

Congratulations, you have just created your first Menu disk!
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6. Support
This section deals with how Bee Software can help you to get the best out of EL
Menu and to deal with any questions you may have with regard to the software. If
you run into difficulties and this user guide is unable to help then you may
contact Bee Software to get more information. Unfortunately Bee Software
cannot offer telephone support. If you do not have access to the Internet please
fax your message to the following number: (01704) 876544. If you are sending
from outside the UK: +44 1 704 876544

6.1 Your Customer Details

In order for Bee Software to help please have ready your product serial number
and your customer ID. These will be given to you when you register the program.
In order to keep these in a safe place please record them in the space provided
below:

Customer ID

Product Serial Number

6.2 email Support

You can email any queries you may have to the following address:

support@beesoftware.com

You will receive a response as soon as possible.

6.3 Using the Program on another PC

The license agreement of EL Menu allows a single user to use the program. This
is accomplished by means of a ‘floating’ license. What happens is that the
program can be installed on more than one PC and the license can be
transferred backwards and forwards by means of a floppy disk.

mailto:support@beesoftware.com
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Follow the same instructions to install the program on the separate computers.
When the program indicates that the installation is unregistered:

• Run EL Menu on the licensed PC.
• Under the ‘Help’ menu choose ‘Export License’.
• Insert a blank formatted high-density floppy disk.
• Click on OK. Wait while the license is exported.
• Click on OK.
• EL Menu will close.
• Go to the other PC.
• Run EL Menu.
• When prompted to register the program click on YES.
• Insert the disk from above into the floppy drive.
• Click on ‘Import from A:/’.
• Wait while the program is registered.
• Click on OK.
• Run EL Menu again.

The license can be moved between the computers as many times as you like
using this system.
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Index
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Paste
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Quick Load

Menu, 21, 23
Registration

Display, 23
Export License, 29

Save Menu File, 19, 27
Support, 28
Track, 24
Track Select, 24
Undo, 20
User Voices, 18


	User Guide
	April 2000

	Use of the Software
	Software is Licensed to a Single Specific User
	Distributable Components
	LIMITED WARRANTY
	DISCLAIMER

	About this Guide
	Structure
	Other Related Documentation

	1. Introducing EL Menu
	1.1 What is a Registration?
	1.2 What is a Registration Menu?
	1.3 What is EL Menu?
	Key Features
	Summary


	2. Installation
	2.1 Before you install EL Menu
	2.2 Installing EL Menu
	To install EL Menu:

	2.3 Registration
	To unlock the program


	3. Getting Started
	3.1 Guided Tour

	4. Working with EL Menu
	4.1 Registrations, Registration Files and Menu files
	Registrations
	Registration Files
	Menu Files

	4.2 Menu Bar
	File
	Edit
	Options

	4.3 Menu Display
	Page Buttons
	Page Title
	Registration Names
	Load Menu
	Save Menu

	4.4 Registration Display
	Registration Buttons
	Track Select
	Load Registration File


	5. Step by Step to Your First Menu Disk
	5.1 Starting a New Menu
	5.2 Loading your registrations
	5.3 Transferring and naming your registrations
	5.4 Naming the menu page
	5.5 Saving the Menu on the PC
	5.7 Creating a Menu Disk to use with the EL

	6. Support
	6.1 Your Customer Details
	6.2 email Support
	6.3 Using the Program on another PC

	Index



